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1. Introduc�on 

1.1 Defini/ons 

Contractor: Includes both General Contractors and Construc/on Manager at Risk (CMAR) 

1.2 Disclaimer 

It is the Consultant's responsibility to ensure that all schedule submi>als during the design process comply with 

UMass Chan’s contract and specifica/on requirements. The Consultant remains accountable for the overall 

proposed design, design schedule, and all applicable deliverables during the design and construc/on 

administra/on (CA) phase. 

Once the Contractor is engaged, it becomes the Contractor’s responsibility to ensure that schedule submi>als 

comply with UMass Chan’s contract and specifica/on requirements. The Contractor remains accountable for the 

project scope of work, means and methods, and the planned sequence of construc/on ac/vi/es. 

UMass Chan makes no representa/ons or warran/es, express or implied, regarding the accuracy, reliability, or 

completeness of the toolkit or the informa/on contained therein. The Owner assumes no liability or responsibility 

for any damages, losses, or claims arising from the use, misuse, or inability to use the toolkit, including any 

improper or incorrect applica/on. 

The Owner reserves the right to update, amend, or remove informa/on contained in the toolkit at any /me 

without prior no/ce. Users should consult the Owner’s website for the most current version of the toolkit. 

1.3 Contract Requirements for Schedules and Submi>als 

The Owner’s Schedule Toolkit is an extension of the Project Schedule Specifica/on, as outlined in the General 

Condi/ons Sec/on 6 and General Requirements Sec/on 13200. It is intended to provide Contractors with guidance 

and support in mee/ng all schedule specifica/on requirements. 

The toolkit includes this document, a Primavera schedule (.XML) file, and Primavera P6 EPPM schedule layout 

(.PLF) files. For projects u/lizing OPC, Contractors should request the required views directly from the Owner 

Project Manager and Project Controls. 

The toolkit is designed to: 

• Establish a schedule backbone that aligns with soEware requirements. 

• Reduce the administra/ve burden of configuring the schedule plaForm. 

• Provide standard reports, calendars, ac/vity IDs, and layouts that meet Owner requirements. 

1.4 Schedule SoEware Requirements 

The table below establishes the approved scheduling soEware based on the project’s Owner Cost and outlines the 

schedule types required for submission. 
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Construction Cost Range Scheduling Platform Required Schedule Types 

Design Schedules 

Microsoft Project, 

Primavera P6, Oracle 

OPC, Other (if approved 

by the Owner in advance) 

-Not applicable 

Under $1M 

Microsoft Project, 

Primavera P6 or Oracle 

OPC  

- Baseline Schedule  

- Monthly Progress Schedule Updates 

(Narrative not required for construction 

projects under $500K) 

- Lookahead Schedules  

- Recovery Schedules  

- Proposal Schedules  

- Delay Notices  

- Time Impact Analysis  

— 
Primavera P6 or Oracle 

OPC  

- Baseline Schedule  

- Monthly Progress Schedule Updates  

- Lookahead Schedules  

- Recovery Schedules  

- Proposal Schedules  

- Delay Notices  

- Time Impact Analysis  

 

1.5 Roles and Responsibili/es 

This Schedule Toolkit provides standards and guidelines for both Design and Construc/on schedules. The 

Consultant and Contractor are expected to work collabora/vely to prepare, update, and maintain schedules in 

accordance with Owner requirements. The table below defines the roles and responsibili/es of each party. 

Entity 
Design Schedule & 

Monthly Updates 

Construction Schedule 

& Monthly Updates 

UMass Chan Medical School Review & Approve Review & Approve 

Design Team Develop Review 

Contractor N/A Develop 
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2. Schedule So-ware Se4ngs 

2.1 Oracle Primavera Se*ngs 

This template was created using the schedule se*ngs found under Tools > Schedule > Op/ons. Contractors must 

use these same se*ngs for all schedule submissions. Figure 1 shows P6 EPPM Se*ngs. Figure 2 shows Oracle OPC 

Se*ngs.  

NOTE: For schedules that are created in MS Project, refer to Sec/on 2.2 below for further ways to mimic these 

se*ngs. 

 
Figure 1: P6 Schedule Se4ng 
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Figure 2: OPC Schedule Se4ngs 

 
2.2 MS Project – Recommended Se*ngs 

When schedules are developed in MicrosoE Project, users must take addi/onal steps to configure the system so 

that outputs are consistent with Primavera-based schedules.  MS Project and Primavera differ in how they handle 

calendars, task types, constraints, rela/onships, and progress measurement. To minimize these differences, 

schedules created in MS Project should be configured with the following considera/ons: 

• Calendar and Time Units – Set hours per day, week, and month to match Primavera defaults (8 hours/day, 

40 hours/week, 20 days/month). Align work hours and non-workdays with the approved project calendar. 

• Task Types and Dura�ons – Default to Fixed Dura/on tasks and turn off “Effort Driven” to prevent 

unintended recalcula/ons when resources are added. 

• Rela�onships and Lags – Use Finish-to-Start as the default dependency and apply lags in working /me 

only.  Avoid “elapsed” dura/ons unless inten/onal. 

• Constraints – Apply constraints sparingly, using equivalents (e.g., “Must Finish On” for Mandatory Finish). 

Ensure “Tasks will always honor constraint dates” is enabled. 
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• Progress Measurement – Use Physical % Complete to align with Primavera’s flexibility for earned value 

and performance tracking. 

• Cri�cal Path Se4ngs – Define cri/cal tasks as those with Total Float � 0 days, consistent with Primavera’s 

default cri/cal path method. 

These se*ngs help ensure that MS Project schedules mirror Primavera logic as closely as possible, allowing for 

consistency in repor/ng, review, and compliance with the Owner’s schedule specifica/on. 

2.3 Calendars 

Primavera uses ac/vity calendar assignments to define allowable work periods. To support consistency, the Owner 

has developed a set of standard calendars that reflect the work periods typically encountered on Owner projects. 

These calendars align with the Owner’s standard specifica/ons and account for common work restric/ons. 

The following standard calendars have been created within the OPC soEware. Non-shaded calendars represent 

Default/Global op/ons, while shaded calendars represent UMass-specific calendars. 

 
Figure 3: (Example) OPC Template Calendar View 

NOTE: Any request to use a calendar outside of the standard set must be submi>ed in advance and approved by 

the Owner Project Manager and Project Controls. 

2.4 Holidays 

The template schedule has been updated to include Massachuse>s state holidays through 2030. Official holiday 

informa/on can be found at: h+ps://www.sec.state.ma.us/divisions/cis/holiday-info.htm  

Holiday 2025 2026 2027 2028 2029 2030 

New Year’s Day  Jan. 1, Wed. Jan. 1, Thur. Jan. 1, Fri. Jan. 1, Sat. Jan. 1, Mon. Jan. 1, Tue. 
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MLK Jr. Day  Jan. 20, Mon. Jan. 19, Mon. Jan. 18, Mon. Jan. 17, Mon. Jan. 15, Mon. Jan. 21, Mon. 

Patriots’ Day  Apr. 21, Mon. Apr. 20, Mon. Apr. 19, Mon. Apr. 17, Mon. Apr. 16, Mon. Apr. 15, Mon. 

Memorial Day  May 26, Mon. May 25, Mon. May 31, Mon. May 29, Mon. May 28, Mon. May 27, Mon. 

Juneteenth  Jun 19, Thu. Jun 19, Fri. Jun 19, Sat. Jun 19, Mon. Jun 19, Tue. Jun 19, Wed. 

Independence 

Day  
Jul. 4, Fri. Jul. 4, Sat. Jul. 4, Sun. Jul. 4, Tue. Jul. 4, Wed. Jul. 4, Thu. 

Labor Day  Sep. 1, Mon. Sep. 7, Mon. Sep. 6, Mon. Sep. 4, Mon. Sep. 3, Mon. Sep. 2, Mon. 

Columbus Day  Oct. 12, Mon. Oct. 9, Mon. Oct. 11, Mon. Oct. 9, Mon. Oct. 8, Mon. Oct. 14, Mon. 

Veterans’ Day  Nov. 11, Tue. Nov. 11, Wed. Nov. 11, Thu. Nov. 11, Sat. Nov. 11, Sun. Nov. 11, Mon. 

Thanksgiving  Nov. 27, Thu. Nov. 26, Thu. Nov. 25, Thu. Nov. 23, Thu. Nov. 22, Thu. Nov. 28, Thu. 

Christmas Day Dec. 25, Thu. Dec. 25, Fri. Dec. 25, Sat. Dec. 25, Mon. Dec. 25, Tue. Dec. 25, Wed. 

Figure 5: MA Holidays Through 2030 

NOTE: Commencement Week is designated as a non-work period. The Consultant and Contractor shall be 

responsible for confirming the exact dates with the Owner Project Manager and Project Controls. Once confirmed, 

these dates must be incorporated into the project schedule as non-workdays. 

2.5 Repor/ng Milestones  

For each project type, specific Repor/ng Milestones must be created and linked to the relevant ac/vi/es. These 

milestones use designated Ac/vity IDs that are required for UMass Chan Medical School repor/ng. They are 

intended solely for Owner repor/ng and do not cons/tute Contractual Milestones unless explicitly iden/fied in the 

contract. 

A lis/ng of the minimum milestone requirements for design, along with full project schedules, can be found in the 

Repor�ng Milestones sec/ons within this toolkit. 

2.6 Monthly Schedule Updates 

A monthly schedule update must be submi>ed to the Owner within ten (10) calendar days of the beginning of 

each month. Each update shall carry a data date of the first (1st) of the month and include progress up to that 

date. 

All schedule submissions are to be made via UMass Chan’s PMIS to the UMass Chan Project Manager and Project 

Controls and must include the following a>achments: 

• Schedule file in .XML format (for P6 and MS Project) 

• Schedule Narra/ve in PDF format 
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• Required Layouts in PDF format (refer to Sec/on 2.7 for specific layouts. Each layout must be submi>ed as 

a separate PDF) 

Upon submission in PMWeb, schedules will be routed through the predefined workflow for UMass Chan Medical 

School Project Team review and approval. 

2.7 Standardized Schedule Layouts 

2.7.1 Primavera P6 Se4ngs 

Each schedule submission must include standardized schedule reports in PDF format, prepared in full compliance 

with the schedule specifica/ons. To support this requirement, the Owner has provided several Primavera Layout 

(.PLF) files for use by Consultants and Contractors. These layouts must be downloaded, imported, and applied 

when genera/ng reports. 

Required Layouts 

• All Ac/vi/es (General Schedule Layout) 

• Cri/cal Path / Longest Path Layout 

• Near Cri/cal (less than 10 days of float) 

• 3-Week Lookahead Layout 

• Recent Progress Layout (with variance to dates and total float of previous update) 

• Baseline Variance Layout 

Impor�ng Layout Files 

• Import each layout separately: View → Layouts → Open → Import 

• AEer import, select the desired layout: View → Layouts → Open 

Required Informa�on in All Schedule Reports 

Unless otherwise specified, all schedule reports must include the following: 

• Schedule Informa/on – Columns View 

o Current Schedule: Ac/vity ID, Ac/vity Name, Start, Finish, Total Float 

o Baseline Schedule: Baseline Start, Baseline Finish, Baseline Total Float, Variance of Baseline Finish 

o Note: Start and Finish dates must use Primavera “Start” and “Finish” fields. 

• Schedule Informa/on – Bars View 

o Bar styles, colors, target informa/on, and calendar forma*ng. 

• Grouping and Sor/ng 
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o Appropriate grouping and sor/ng must be applied to ensure clarity. 

• Data Filtering 

o Filters should be applied as necessary to support the purpose of the report. 

• Administra/ve Report Informa/on 

o Headers and footers, report /tles, page breaks, page numbers, and all other required forma*ng. 

2.7.2 Primavera OPC Se4ngs 

Each schedule submission must include standardized schedule reports in PDF format, prepared in full compliance 

with the schedule specifica/ons. To support this requirement, the Owner has developed Primavera OPC Views for 

use by Consultants and Contractors. These Views must be requested from the Owner Project Manager and Project 

Controls and applied when genera/ng reports. 

Required Views 

• All Ac/vi/es (General Schedule View) 

• Cri/cal Path / Longest Path View 

• Near Cri/cal (less than 10 days of float) 

• 3-Week Lookahead Layout 

• Recent Progress View (with variance to previous update) 

• Baseline Variance View 

Applying Views in OPC 

• Request the standardized Views from the Owner Project Manager and Project Controls. 

• Import or load each View into the OPC workspace as directed. 

• Apply the desired View when preparing schedule reports. 

Required Informa�on in All Schedule Reports 

Unless otherwise specified, all OPC-generated schedule reports must include the following: 

• Schedule Informa/on – Table View 

o Current Schedule: Ac/vity ID, Ac/vity Name, Start, Finish, Total Float 

o Baseline Schedule: Baseline Start, Baseline Finish, Baseline Total Float, Variance of Baseline Finish 

o Note: Start and Finish dates must use the OPC “Start” and “Finish” fields. 

• Schedule Informa/on – Gan>/Chart View 

o Bar styles, colors, target informa/on, and calendar forma*ng consistent with Owner standards. 
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• Grouping and Sor/ng 

o Appropriate grouping and sor/ng must be applied to ensure clarity. 

• Data Filtering 

o Filters should be applied as necessary to support the purpose of the report. 

• Administra/ve Report Informa/on 

o Headers and footers, report /tles, page breaks, page numbers, and all other required forma*ng. 

2.7.3 MS Project Se4ngs 

Each schedule submission must include standardized schedule reports in PDF format, prepared in full compliance 

with the schedule specifica/ons. To support this requirement, the Owner has defined standardized Views, Tables, 

Filters, and Groupings for use by Consultants and Contractors. These configura/ons must be downloaded or 

requested from the Owner Project Manager and Project Controls, then applied when genera/ng reports. 

Required Views/Reports 

• All Ac/vi/es (General Schedule View) 

• Cri/cal Path / Longest Path View 

• Near Cri/cal (less than 10 days of float) 

• 3-Week Lookahead Layout 

• Recent Progress View (with variance to previous update) 

• Baseline Variance View 

Applying Views in Microso- Project 

• Import or create the required Views, Tables, and Filters as directed by the Owner Project Manager and 

Project Controls. 

• Select the appropriate View from the View tab. 

• Apply the required Table, Filter, and Grouping op/ons to format the report. 

• Export the forma>ed output to PDF for submission. 

Required Informa�on in All Schedule Reports 

Unless otherwise specified, all MicrosoE Project–generated reports must include the following: 

• Schedule Informa/on – Table (Columns) View 

o Current Schedule: Task ID, Task Name, Start, Finish, Total Slack 

o Baseline Schedule: Baseline Start, Baseline Finish, Baseline Total Slack, Variance of Baseline Finish 
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o Note: Start and Finish dates must use the “Start” and “Finish” fields, not Actual Start/Finish unless 

specifically instructed. 

• Schedule Informa/on – Gan> Chart View 

o Bar styles, colors, target informa/on, and calendar forma*ng consistent with Owner standards. 

• Grouping and Sor/ng 

o Apply grouping and sor/ng rules for clarity (e.g., by WBS, Phase, Discipline, or Contractor-provided 

coding). 

• Data Filtering 

o Apply filters as necessary to meet the intent of the report (e.g., Cri/cal Path, Near Cri/cal, or 

Lookahead). 

• Administra/ve Report Informa/on 

o Headers and footers, report /tles, page breaks, page numbers, and all other required forma*ng. 

3. Project Schedules 

3.1 Purpose of a Design Schedule 

The Owner’s Design Schedule Toolkit is an extension of the Project Schedule Specifica/on and is intended to 

provide Consultants with support and guidance in mee/ng the requirements of the schedule specifica/on.  

The objec/ve is to u/lize the design schedule informa/on for planning, controlling, and repor/ng design and 

engineering ac/vi/es. This narra/ve provides step-by-step instruc/ons for crea/ng the design schedule, which will 

be used to es/mate and manage the dura/on of the design por/on of the project. 

The intent to use a design schedule is to: 

• To help the Owner adjust to changes during design. 

• It can be used to prepare proac/ve recovery/accelera/on plans during changes/delays during the design 

phase.  

• Develop a tracking and repor/ng process that helps the Owner monitor schedule status and to ini/ate 

correc/ve ac/on (if required). 

• Produce reports to help the Owner’s management team evaluate the capital program. 

• Improve logis/cs. 

• Provides a schedule backbone that supports the soEware requirements. 

• Minimizes the administra/ve burden of adjus/ng the schedule plaForm to meet these requirements. 

• Provide standard reports, calendars, ac/vity IDs, and layouts that meet the Owner’s requirements. 
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The Consultant is requested to submit a Design Schedule to track the project’s design phase effort. The schedule 

should track work as outlined in the Work Order and be submi>ed simultaneously with the Work Order. This 

schedule will represent the Consultant’s Baseline Schedule.  

3.2 Design Repor/ng Milestones 

The Contract requires the following Repor/ng Milestones to be included with all schedule submissions. All 

repor/ng milestones should be assigned the 7-day calendar with no holidays provided. These Repor/ng 

Milestones are used solely for UMass Chan Medical School Repor/ng purposes, and they do not serve as 

“Contractual Milestones” unless they are applicable to the contract. 

As noted in the schedule specifica/on, the ac/vity ID and ac/vity name must match what has been provided in 

the specifica/on (as listed below). In addi/on, the ac/vity ID and ac/vity name must not change through the design 

phase. 

The Consultant should inform UMass Chan Medical School if some of these repor�ng milestones are not applicable 

to their project or require u�lizing different milestones. 

 

Figure 6: UMC Design Milestones 

3.3 Schedule WBS 

Each schedule submission must follow the Work Breakdown Structure (WBS) provided in this toolkit. The standard 

WBS is included in the schedule toolkit .XML file and serves as the primary framework for schedule organiza/on 

and grouping. Addi/onal WBS levels may be added at the Consultant’s discre/on but require prior approval from 

the Owner and Project Manager.  

  

Figure 7: Project Schedule WBS Example 
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3.3.1 Summary Ac�vi�es 

The Consultant must set up Summary Level Ac/vi/es to align with the Work Order. Requirements include: 

• Dura/ons of Summary Level Ac/vi/es must match those in the Work Order. 

• Summary Level Ac/vi/es must be cost-loaded, with costs derived from the level of effort in the Work 

Order. 

• Ac/vity dura/ons should not be shorter than one (1) week. 

• Lower-level ac/vi/es must roll up to their respec/ve Summary Level Ac/vi/es. 

• Summary Level Ac/vi/es must roll up to the milestones defined in this toolkit. 

3.3.2 Ac�vi�es Se4ngs 

The WBS will remain the primary method of schedule organiza/on and grouping. Ac/vity codes may also be added 

at the vendor’s discre/on; however: 

• All ac/vity codes must be maintained at the Project Level. 

• Global ac/vity codes will not be accepted. 

3.4 Schedule Updates 

3.4.1 Update Cycle 

The Consultant must submit a monthly schedule update by the 10th of each month. Each update shall use a Data 

Date of the first (1st) of the month. All updates must comply with the requirements outlined within this Schedule 

Toolkit 

3.4.2 Performance Measurement 

Ac/vi/es must accurately reflect the actual progress achieved during the repor/ng period. Progress shall be 

updated using either the Es/mated Finish Date or Remaining Dura/on. 

 

3.4.3 Schedule Changes 

When a new Work Order or Work Order Amendment is issued and approved, the Consultant must update the 

schedule accordingly and document any changes in the Narra/ve submi>ed to UMass Chan Medical School. 

• If changes affect milestone dates and require a revision to the Baseline schedule, the Consultant must 

no/fy UMass Chan Medical School and obtain approval prior to implemen/ng Baseline changes. 

3.5 Schedule Narra/ve 

As outlined in the Schedule Specifica/on and Consultant Contracts, all schedule submissions must be accompanied 

by a detailed wri>en narra/ve. The Consultant’s narra/ve shall include, at a minimum, the following: 
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3.5.1 Execu�ve Summary 

• General statement of whether the project is on schedule, ahead, or behind. 

• Key indicators: progress vs. plan, overall percent complete, and major milestone status. 

3.5.2 Milestone Chart 

• Show original and modified Contractual (or approved Baseline) dates. 

• Include current and previous forecasted dates for all interim and Contractual milestones. 

• Provide variance columns comparing: 

o Current vs. Contractual 

o Current vs. Modified Contractual 

o Current vs. Previous 

3.5.3 Assump�ons 

• List any assump/ons made in preparing the update. 

• Progress Summary 

• Describe work completed during the repor/ng period. 

3.5.4 Outstanding Decisions 

• Iden/fy responses required for key decisions. 

• Indicate which items are cri/cal or near cri/cal (based on total float). 

• Provide the date by which a response is needed. 

3.5.5 Changes Since Last Update 

• List and explain all changes from the previous update. 

• List of added and deleted ac/vi/es 

3.5.6 Planned Percent Complete 

• Report the current planned percent complete. 

4. Construc�on Schedules 

4.1 Purpose of a Construc/on Schedule 

The Owner’s Construc/on Schedule Toolkit is an extension of the Project Schedule Specifica/on and is intended 

to provide Contractors with support and guidance in mee/ng the requirements of the schedule specifica/on. The 

toolkit is comprised of this document, a Primavera schedule (.XML) file, and Primavera schedule layout (.PLF) files. 
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For schedules developed in MicrosoE Project, the Owner provides equivalent standardized Views, Tables, Filters, 

and Groupings. These configura/ons are designed to replicate the requirements of the Primavera layouts and 

should be applied when genera/ng schedule reports. Contractors are responsible for reques/ng these 

configura/ons from the Owner Project Manager and Project Controls and ensure they are incorporated into all 

schedule submi>als. 

The objec/ve is to use the construc/on schedule informa/on for planning, sequencing, controlling, and repor/ng 

Construc/on Ac/vi/es. This narra/ve provides step-by-step instruc/ons for crea/ng the construc/on schedule, 

which will be used to es/mate, monitor, and manage the dura/on and sequencing of the construc/on por/on of 

the project. 

The intent of using a construc/on schedule is to: 

• Assist the Owner in an/cipa/ng and adap/ng to changes during the construc/on phase. 

• Provide a tool for developing proac/ve recovery and accelera/on plans in response to delays, disrup/ons, 

or changed condi/ons. 

• Establish a process for tracking and repor/ng construc/on progress, enabling the Owner to monitor 

schedule status and require correc/ve ac/on if necessary. 

• Produce reports that support the Owner’s management team in evalua/ng project and program-level 

performance. 

• Improve coordina/on among the Contractor, subcontractors, suppliers, and Owner representa/ves. 

• Define and communicate the planned sequence of work, including cri/cal path ac/vi/es and interfaces 

with other trades or contracts. 

• Support planning for field logis/cs, site access, material deliveries, and resource alloca/on. 

• Provide a resource- and cost-loading framework to monitor produc/vity and support earned value analysis 

(if required by the Contract). 

• Supply standard reports, calendars, ac/vity IDs, and layouts that align with the Owner’s requirements. 

The Contractor is required to submit a Construc/on Schedule that fully represents the project scope of work as 

defined in the Contract Documents. The schedule must reflect the Contractor’s means and methods, subcontractor 

coordina/on, and planned sequence of work. The Baseline Construc/on Schedule must be submi>ed for approval 

prior to the commencement of construc/on ac/vi/es.  

4.2 Baseline Schedule  

The Contractor is required to submit the Ini/al Baseline Schedule within fourteen (14) calendar days from No/ce 

to Proceed (NTP). The Baseline Schedule must be submi>ed through UMass Chan’s PMIS and shall reflect the full 

scope of work awarded to the Contractor. Once accepted by UMass Chan Medical School, the Baseline Schedule 

will be designated as the Baseline Schedule of Record and will serve as the measurement tool for tracking and 

comparing all project progress. 
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To monitor schedule variance over /me, all schedule reports must include comparisons to both the previous 

update and the current accepted Baseline Schedule. For this purpose: 

• In Primavera P6 and OPC: 

o The previous month’s schedule file shall be assigned as the Primary Baseline. 

o The current accepted Baseline Schedule shall be assigned as the User Baseline – Primary. 

o In Primavera, these assignments can be made under Project → Assign Baseline. 

• In MicrosoE Project: 

o The previous month’s schedule should be saved as Baseline 1 (or next available interim baseline). 

o The current accepted Baseline Schedule should be saved as the Project Baseline (Baseline 0). 

o These assignments are made under Project → Set Baseline, where the user can select either the 

full project or specific tasks. 

Both Primavera and MS Project schedules must be configured so that monthly reports show variances against the 

prior update and the Baseline Schedule of Record. 

4.3 Construc/on Repor/ng Milestones 

The Contract requires the following Repor/ng Milestones to be included with all schedule submissions. All 

Repor/ng Milestones shall be assigned to a 7-day calendar with no holidays. These milestones are used solely for 

UMass Chan Medical School repor/ng purposes and do not cons/tute “Contractual Milestones” unless specifically 

iden/fied as such in the Contract. 

As stated in the schedule specifica/on, the Ac�vity ID and Ac�vity Name must match exactly as provided in the 

specifica/on (see list below). These iden/fiers shall remain unchanged for the dura/on of the project. 

If certain Repor/ng Milestones are not applicable to the project, or if alterna/ve milestones are required, the 

Contractor shall no/fy UMass Chan Medical School for review and approval. 
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Figure 7: UMC Project Milestones 

 

4.4 Schedule WBS 

Each schedule submission must follow the Work Breakdown Structure (WBS) provided below, which is also 

included in the Schedule Toolkit .XML file. The WBS structure shown serves as the primary framework for 

organizing and grouping schedule ac/vi/es. Contractors may add further WBS detail at their discre/on to support 

project-specific needs, provided the required structure is maintained. 

NOTE: The WBS levels provided by the Owner must not be altered or renamed. Any addi/onal WBS detail added 

by the Contractor shall be supplemental and subordinate to the required structure. 
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Figure 8: Construc�on Schedule WBS 

4.4.1 Summary Ac�vi�es 

The Contractor is required to develop Summary Level Ac/vi/es (Level of Effort) derived from the project’s detailed 

ac/vi/es. These Summary Ac/vi/es shall align with the line items in the approved Schedule of Values (SOV) and 

will roll up to the designated Repor/ng Milestones.  These ac/vi/es will enable the UMass Chan team to develop 

project cash flows and track the project's financial progress over /me. 

4.4.2 Ac�vi�es Se4ngs 

Individual Schedule Ac/vity dura/ons shall not exceed eighteen (18) calendar days. This limit ensures that ac/vi/es 

are developed at a level of detail that supports effec/ve monitoring, accurate progress measurement, and early 

iden/fica/on of poten/al delays. Shorter ac/vity dura/ons improve the reliability of schedule updates, provide 

clearer visibility into work progress, and enable /mely correc/ve ac/ons when issues arise. All ac/vi/es must be 

organized to roll up appropriately to the Summary Level Ac/vi/es. 

Best Prac�ce Note: This requirement is consistent with industry standards (e.g., AACE Interna/onal, CMAA, 

NAVFAC), which generally recommend limi/ng ac/vity dura/ons to 10–20 workdays. This range is considered 

op/mal for balancing schedule manageability with meaningful progress tracking. 

4.5 Schedule Updates 

4.5.1 Update Cycle 

The Contractor is required to submit a monthly schedule update for work performed, no later than the 10th day 

of each month. Each submission shall use a Data Date of the 1st day of the month. All updates must be prepared 

in accordance with this Schedule Toolkit. 

4.5.2 Performance Measurement  

The Owner requires that all schedule ac/vi/es use Physical % Complete as the performance measurement 

method.  The physical % complete is a measure of the actual physical work completed on a specific task, rather 

than the amount of /me or dura/on that has passed.  This se*ng ensures that progress reflects the actual work 

performed during each monthly update period. 

• Primavera P6: Set the % Complete Type field to Physical for all ac/vi/es. 
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• Primavera OPC: Configure each ac/vity’s Progress Measurement se*ng to Physical % Complete. 

• Microso- Project: Assign the project’s Earned Value Method to Physical % Complete (available in Task 

Informa/on → Advanced tab). 

Physical % Complete values shall be reviewed and updated in each repor/ng period. Reported progress must 

accurately represent the work accomplished, not just the passage of /me or resource expenditure. 

4.6 Schedule Narra/ve 

As required by General Requirements, Sec/on 13200 of the schedule specifica/on, all schedule submissions shall 

be accompanied by a detailed wri>en narra/ve. The purpose of the narra/ve is to clearly explain the logic, 

assump/ons, progress, variances, and changes reflected in the schedule update so that the Owner can evaluate 

both current status and future impacts. At a minimum, the Contractor’s narra/ve shall address the following: 

• Milestone Chart 

o Provide a milestone chart that includes the original and any modified Contractual (or approved 

baseline) dates, along with the current and previous forecast dates for all interim and Contractual 

milestones. 

o Include variance columns for: 

 Current vs. Contractual 

 Current vs. Modified Contractual 

 Current vs. Previous Update 

• Execu/ve Summary 

o Provide a high-level summary highligh/ng key progress, issues, and overall schedule status. 

• Longest Path 

o Describe the scope of work and major sequences for all ac/vi/es on the Longest Path. Explain any 

changes since the previous update. 

o Compare early and late dates for ac/vi/es on the Longest Path. Provide explana/ons for changes 

to the top three longest paths. 

o Describe the Contractor’s plan, approach, methodologies, and resources for comple/ng the work 

on the top three longest paths. 

• Progress 

o Summarize work progress during the current update period. 

o Provide a look-ahead summary for the forthcoming update period. 

o Iden/fy and explain all changes to the schedule during the update period, including addi/ons, 

dele/ons, or modifica/ons to milestones, ac/vi/es, logic rela/onships, codes, WBS, etc. 

• Delays and No/ces 
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o Reference any No/ces of Delay issued during the period. 

o Provide a detailed discussion of added ac/vi/es that reflect the delay and explain how the delay 

affects the project’s cri/cal path. 

• Specifica/on Compliance 

o Iden/fy and explain all areas where specifica/on requirements are not being addressed or 

followed. 

• Key Decisions 

o Provide a list of responses required for key decisions. 

o Iden/fy items that are cri/cal or near cri/cal (based on project total float), along with the required 

response dates. 

• Recovery / Early Comple/on 

o Provide an explana/on of possible measures to achieve early comple/on or to recover schedule 

slippage. 

• Calendars 

o List all ac/vity calendars being used. 

o Explain the use of shiE work. 

o Iden/fy and explain any changes to calendar usage since the previous submission. 

• Out-of-Sequence Logic 

o Iden/fy and explain all instances of out-of-sequence ac/vity logic. 

• Planned Percent Complete Update 

o Provide an update of Planned Percent Complete values. 

4.7 Change Management 

4.7.1 Schedule Changes 

When Bulle/ns are issued and approved, the Contractor shall update the schedule to reflect the associated 

changes in scope, sequencing, or dura/on of ac/vi/es. The revised schedule must be submi>ed as part of the next 

monthly schedule update through PMWeb for UMass Chan Medical School review and approval. 

All schedule changes shall: 

• Clearly iden/fy the ac/vi/es impacted by the Bulle/n. 

• Incorporate any new ac/vi/es, logic /es, or resources required to execute the Bulle/n work. 

• Include adjustments to milestones, interim dates, or cri/cal path ac/vi/es if applicable. 

• Maintain traceability by documen/ng the reason for each change in the schedule narra/ve. 
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• Provide variance repor/ng that compares the revised schedule to both the previous update and the 

current Baseline Schedule of Record. 

The Contractor is responsible for ensuring that all approved Bulle/ns are integrated promptly into the project 

schedule, so that UMass Chan Medical School has an accurate and /mely representa/on of the project's status 

and forecasted comple/on. A WBS shall be set up to track the issuance data and approval process of the Bulle/n, 

and the corresponding ac/vi/es shall be integrated into the overall project schedule.  A naming conven/on and 

ac/vity code should be added to each task associated with a Bulle/n to ensure ease of review, tracking, and 

repor/ng.   

4.7.2 Pending Changes / Fragnets 

When a change is under review but not yet approved, the Contractor shall prepare a fragnet (a group of ac/vi/es 

that represents the proposed change) and incorporate it into the project schedule for analysis. Pending changes 

must be clearly iden/fied and dis/nguished from approved work. These fragnets may be submi>ed as “what-if” 

scenarios or /me impact studies to demonstrate the poten/al effect of the change on Contract milestones and the 

project’s cri/cal path. Pending changes should not alter the official schedule of record un/l formal approval is 

received. 

4.7.3 Time Impact Analysis (TIA) 

For any change, delay, or event that may affect Contract milestones, the Contractor shall prepare and submit a 

Time Impact Analysis (TIA). TIAs must be based on the accepted schedule of record in place at the /me the event 

occurred. Each TIA shall include: 

• A fragnet illustra/ng the addi/onal or revised work scope, logic /es, and dura/ons. 

• Iden/fica/on of the ac/vi/es impacted, including changes to cri/cal and near-cri/cal paths. 

• An updated forecast of milestone comple/on dates. 

• Suppor/ng narra/ve that explains assump/ons, methodology, and conclusions. 

TIAs shall be submi>ed promptly for UMass Chan Medical School review and approval in accordance with the 

Contract requirements for change management and delay claims. 

4.7.4 Change Log / Documenta�on 

The Contractor shall maintain a change log that records all schedule modifica/ons, whether due to approved 

Bulle/ns, Change Orders, or other direc/ves. Each entry must include a reference to the change document, the 

date incorporated, and a descrip/on of the ac/vi/es affected. The change log shall be submi>ed as part of each 

monthly schedule update and cross-referenced in the narra/ve. The log must clearly iden/fy whether the change 

is approved, pending, or withdrawn, ensuring full transparency of schedule revisions throughout the project. 

4.7.5 Baseline Revisions / Re-baselining 

In cases where significant scope changes, major delays, or contract modifica/ons occur, the Contractor may be 

required to develop and submit a Revised Baseline Schedule. The Revised Baseline shall reflect the updated project 
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scope and sequencing and will serve as the new Baseline Schedule of Record once accepted by UMass Chan 

Medical School. Re-baselining requires prior approval from the Owner, and the Contractor’s request must include 

jus/fica/on, suppor/ng documenta/on, and a clear explana/on of why a re-baseline is necessary. 

 


